
Fundamentals of IT & Programming 

1. What are the four fundamental parts of 

computer? Explain it with the help of diagram? 

Fundamentals parts of computer are Input Unit, Output unit, Processing Unit 

and Memory Unit. 

 

 

 

 

 

 

The 3 major functions of the input unit are – 

1. Take the data to be processed by the user. 

2. Convert the given data into machine -readable form. 

3. And then, transmit the converted data into the main memory of the computer. 

The sole purpose is to connect the user and the computer. In addition, this 

creates easy communication between them. 

CPU – Central Processing Unit 

 Central Processing Unit or the CPU, is the brain of the computer. It works 

the same way a human brain works. As the brain controls all human activities, 

the CPU to controls all tasks. 

Moreover, the CPU conducts all the arithmetical and logical operations in the 

computer. 

 Now the CPU comprises of two units, namely – ALU (Arithmetic Logic 

Unit) and CU (Control Unit). Both of these units work in sync. The CPU 

processes the data as a whole.  

Let us see what particular tasks are assigned to both units. 

 



ALU – Arithmetic Logic Unit 

The arithmetic Logic Unit is made of two terms, arithmetic and logic. There are 

two major functions that this unit performs. 

1. Data inserted through the input unit into the primary memory. Performs the 

basic arithmetical operation on it. Like addition, subtraction, multiplication, and 

division. It performs all sorts of calculations required on the data. Then sends 

back data to storage. 

2. The unit is also responsible for performing logical operations like, AND, OR, 

Equal to, Less than, etc. In addition to this it conducts merging, sorting, and 

selection of the given data. 

CU – Control Unit 

 The control unit as the name suggests is the controller of  all the 

activities/tasks and operations. All this is performed inside the computer. 

 The memory unit sends a set of instructions to the control unit. Then the 

control unit in turn converts those instructions. After that these instructionsare 

converted to control signals. 

 These control signals help in prioritizing and scheduling the activities. 

Thus, the control unit coordinates the tasks  inside the computer in sync with the 

input and output units. 

Memory Unit 

  All the data that has to be processed or has been processed stored in the 

memory unit. The memory unit acts as a hub of all the data. It transmits it to the 

required part ofthe computer whenever necessary. 

 The memory unit works in sync with the CPU. This helps in faster 

accessing and processing of the data. Thus, making tasks easier and faster. 

There are two types of computer memory-  

1. Primary memory – This type of memory cannot store a vast amount of data. 

Therefore, it is only used to store recent data. The data stored in this is 

temporary. It can get era 

2. sed once the power is switched off. Therefore, is also called temporary memory 

or the main memory. 

RAM stands for Random Access Memory. It is an example of primary 

memory. This memory is directly accessible by the CPU. It is used for reading 



and writing purposes. For data to be processed, it has to be first transferred to 

the RAM and then to the CPU. 

3. Secondary memory– As explained above, the primary memory stores 

temporary data. Thus it cannot be accessed in the future. For permanent storage 

purposes, secondary memory is used. It is also called the permanent memory or 

the auxiliary memory. The hard disk is an example of secondary memory. Even 

in a power failure data does not get erased easily. 

Output 

There is nothing to be amazed by what the output unit is used for. All the 

information sent to the computer once processed is received by the user through 

the output unit. Devices like printers, monitors, projector, etc. all come under 

the output unit. 

 The output unit displays the data either in the form of a soft copy or hard 

copy. The printer is for the hard copy. The monitor is for the display. The output 

unit accepts the data in binary form from the computer. It then converts it into a 

readable form for the user 

2. Discuss about the classification of computers based on size and 

capacity? 

 

 

 

 

 

 

 

1. Super Computer 

A Supercomputer is the very fastest and powerful, and expensive type of 

computer for processing data. Supercomputers’ size and storage capacity are 

also huge (can occupy huge premises) designed to process vast amounts of data 

in a short time with high productivity. 



 These are specially made to perform multi-specific tasks. Therefore, many 

CPUs work in parallel order on these supercomputers. This function of a 

Supercomputer is called Multiprocessing or Parallel Processing. 

A supercomputer’s design is complicated, like it can be heterogeneous, 

combining computers of different architectures, is significantly surpassed most 

existing personal  computers. This made this machine an ultra-high-

performance supercomputer. 

Each part of a supercomputer is responsible for its own specific task, such as 

structuring and solving the most complex problems requiring an incredible 

amount of calculations. 

Applications: The uses of supercomputers are dedicated to – 

 In research and study of energy and nuclear weapons and designing the 

aircraft, airplanes, and flight simulators. 

 Climate research and Weather Forecasting and Prediction of Natural  

Disasters. 

 Spaceship and Satellite Launching. 

 Used in scientific research laboratories. 

 Used in Chemical and Biological research and for highly calculation complex 

tasks 

2. Mainframe Computer 

        Mainframe computers are multi-programming, high-performance 

computers, and multi-user, which means it can handle the workload of more 

than 100 users at a time on the computer. 

         The storage capacity of the mainframe is enormous, with a high-speed 

data process as well. As well as handling hundreds of input and output devices 

at a time.  

        The mainframe is a highly efficient computer capable of simultaneously 

solving complex calculations and continuously for a long time. These 



computers have several microprocessors that have the ability to function the 

data at too high performance  and speed. 

        The mainframe is ahead of our conventional modern Personal computers in 

almost every metric. The possibility of their ―hot‖ replacement in the 

mainframe computer ensures continuity of operation. And the standard amount 

of processor utilization effortlessly exceeds 85% of the total power. 

        In today, IBM company is leading the production of mainframe computers. 

Mainframe reliability is increased with development in the past 60 years. These 

computers can fix most of the hardware and software bugs. 

Applications: Uses of Mainframe Computer – 

          Mainframe computers are mainly used by departmental and commercial 

organizations like Banks, Companies, Scientific research centers, and 

governmental departments like railways. These computers can work for 24 

hours. Hundreds of users can work on these computations simultaneously. 

        Using the mainframe completes the tasks, Such as keeping details of 

payments, research centers, advertising, sending bills and notices, paying 

employees, ticket booking, maintaining details of purchases by users, keeping 

detailed tax details, etc. 

3. Mini Computer 

     Minicomputer is a digital and multi-user computer system with the 

connection of  more than one CPU. Thus, many people can work on these 

computers simultaneously instead of a single person. Also, it can process with 

other accessories like a printer, plotter, etc. 

      Minicomputers are the medium type of computers that have more 

functionality power and are expensive than microcomputers. On the other hand, 

the size, storage, and speed of minicomputers are large but less than the 

mainframe and supercomputers. 



      Minicomputers are made for performing multiple computing tasks at a 

single point of time, instead of assigning many microcomputers for a single 

task, which will be timeconsuming and expensive. 

    In general, a minicomputer is a multi-threaded system (several processes at a 

time) capable of supporting from one to up to 200 users simultaneously: these 

computers are currently used to store large databases, multi-user applications, 

and the automation industry 

Applications: The uses of Minicomputers – 

          The minicomputers are used as real-time applications in Industries, 

bookings, and Research Centres. Banks also use minicomputers for preparing 

payroll for employees’ salaries, records, tracking of financial accounts, etc. As 

well as in the field of Higher Education and Engineering. 

4. Micro Computer  

          Today we are using many computers at home is also the most common 

microcomputer. With this invention of the microprocessors in the year 1970, it 

became possible to use computers for people personally at a low cost and 

reasonable price known as Digital Personal Computer. 

           The design of microcomputers is minimal in size and storage capacity. 

These  computers consist of many parts like Input and Output devices, 

Software, operating systems, networks, and Servers all these need to connect to 

form a complete Personal Digital Computer. 

           There is not only a PC or laptop are examples of microcomputers. Other 

examples of the microcomputer are smartphone, Tablet, PDA, server, palmtop, 

and workstation. This can be installed in any work area or even at home for 

personal use. 

            The primary purpose of microcomputers is to keep and process everyday 

tasks and needs of the people. Only one person can work on a single PC at a 

time, but its operating system is multitasking. The PC can be connected to the 

Internet to take benefits and enhance the user experience. 



            The development of multimedia, small equipment, optimized energy 

consumption, and the LAN made the microcomputers increase in demand for 

every field. 

            The increase in the demand and need for microcomputers between the 

people  leads to the tremendous development of each part related to the 

microcomputers. 

Applications: The uses of MicroComputer – 

          PC is being widely used in many fields like home, office, data collection, 

business, education, entertainment, publishing, etc. It keeps the details and 

prepares letters for correspondence in small businesses, creating bills, 

accounting, word processing, and  operation of the filing systems in a large 

company. 

Some of the major PC manufacturers are IBM, Lenovo, Apple, HCL, HP, etc. 

Examples: Desktops, tablets, smartphones, and Laptops. 

The above is the classification of computers according to Size and Capacity! 

Computers on the Basis Purpose 

1. General Purpose 

General computers can do various everyday tasks such as writing a word 

processing letter, Document preparation, recording, financial analysis, Printing 

documents, creating databases, and calculations with accuracy and consistency. 

        The size, storage capacity, and cost of such computers are mainly less. The 

ability of these computers is limited in performing specialized tasks. Still, it has 

versatility and useful for serving people’s basic needs at home or in the 

workplace in the environment. 

Examples: 

Desktops, laptops, smartphones, and tablets are used on daily basis for general 

purposes. 

4. Special Purpose 



           These computers are designed to perform a particular or specialized task. 

The size, storage capacity, and cost of such computers mainly depend on the 

nature and size of the work. The function of these computers is consistent with 

any particular task. The special computer needs specific processors and input 

and devices to conduct work efficiently.  

These computers are used for special purposes in weather forecasting, space 

research, agriculture, engineering, meteorology, satellite operation, traffic 

control, and research in chemical sciences. 

Examples 

Automatic teller machines (ATM), 

 Washing machines, 

 Surveillance equipment, 

 Weather-forecasting simulators, 

 Traffic-control computers, 

Defense-oriented applications, 

 Oil-exploration systems, 

 Military planes controlling computers. 

Computers on the Basis of Hardware Design and Data Handling. 

1. Analog Computer 

An analog computer performs tasks using continuous data (the physical amount 

that changes continuously). Analog computers are used primarily to measure 

physical units like voltage, pressure, electric current, temperature, and convert 

them into digits. It is also used to measure and perform arithmetic calculations 

of numbers, the length of an object, or the amount of voltage that passes through 

a point in an electrical circuit. Analog computers obtain all their data from some 

measurement way. 

Examples: 



     An analog computer installed on a petrol pump measures the amount of 

petrol coming out of the pump and appears in liters. And calculates its value. 

These quantities vary continuously while measuring the amount, such as the 

temperature of a human body changes consistently. 

      A simple clock, the vehicle’s speedometer, Voltmeter, etc. are examples of 

analog computing. 

2. Digital Computer 

As its name suggests, a digital computer represents the digital computer’s 

letters, numerical values, or any other special symbols. This computer is the 

computer thatcalculates the number for processing the data. 

 They run on electronic signs, and the binary numeral method Binary System 0 

or 1 is used for calculation. Their speed is fast. 

       It can perform arithmetic operations such as addition, occurrence, 

subtraction, multiplication, or division and all types of logical(mathematical) 

operations. Today, most of the computers available in the market are digital 

computers. 

      Digital computers are built to bring the solution of equations to an almost 

unlimited precision, but in a bit slow manner compared to analog computers. To 

some extent, they all have similar components for receiving, processing, sorting, 

and transmitting data and use a relatively small number of essential functions to 

perform their tasks. 

      Digital computers use discrete electrical signals for operation rather than 

continuous electrical signals as analog computers have, making them the most 

common form of computers today because of their versatility, speed, and 

power. The desktop or Laptop at our home is one the common and best 

example of a digital computer. 

3. Hybrid Computer 

       A hybrid computer is a combined complex computer unit built using both 

analog and digital properties and united by a single control system. The 



purpose of designing hybrid computers is to provide functions and features that 

can be found on both analog and digital devices. 

Applications of hybrid Computer: 

       Hybrid computers are most commonly used in vast industries, research 

centers, organizations, and manufacturing firms (where many equations need to 

be solved). Also, the solutions and uses of hybrid computers have proved to be 

much more detailed, accurate, and useful. Hybrid computers are used in 

scientific calculations, for nations’ defense and radar systems as well. 

3. What is the meaning of computer generation? How many 

computer Generations are defined? What technologies were/are 

used? 

What is the meaning of computer generation? 

 The generation of computer means the gap between the developments of 

the computer in terms of the technologies. Each generation of computer is 

characterized by a major technologies development that fundamentally changed 

the way computer operate, resulting i smaller, cheaper, and more powerful, 

efficient and reliable device. 

How many computer generations are defined? 

There are Five generations of computers. 

What technologies were / are used? 

The evolution of computer technology is often divided into five generations. 

Five Generations of Computers 

Generations of 

computer 

Generations 

timeline 

Evolving hardware 

First generation 1940s – 1950s Vacuum tube based 

Second generation 1950s – 1960s Transistor based 

Third generation 1960s – 1970s Integrated circuit based 

Fourth generation 1970s – present Microprocessor based 

Fifth generation The present and the 

future 

Artificial intelligence 

based 



The main characteristics of first generation of computers (1940s-

1950s) 

 Main electronic component – vacuum tube 

 Main memory – magnetic drums and magnetic tapes 

 Programming language – machine language  

 Power – consume a lot of electricity and generate a lot of heat.  

 Speed and size – very slow and very large in size (often taking up entire 

room).  

 Input/output devices – punched cards and paper tape.  

 Examples – ENIAC, UNIVAC1, IBM 650, IBM 701, etc. 

 Quantity – there were about 100 different vacuum tube computers produced 

between 1942 and1963. 

Second Generation of Computers 

The main characteristics of second generation of computers (1950s-1960s) 

 Main electronic component – transistor  

 Memory – magnetic core and magnetic tape / disk. 

 Programming language – assembly language. 

 Power and size – low power consumption, generated less heat, and smaller in 

size (in comparison with the first generation computers).  

 Speed – improvement of speed and reliability (in comparison with the first 

generation computers).  

 Input/output devices – punched cards and magnetic tape.  

 Examples – IBM 1401, IBM 7090 and 7094, UNIVAC 1107, etc.  

Third Generation of Computers 

The main characteristics of third generation of computers (1960s-1970s) 

 Main electronic component – integrated circuits (ICs)  

 Memory – large magnetic core, magnetic tape / disk.  



 Programming language – high level language (FORTRAN, BASIC, Pascal, 

COBOL, C, etc.) 

 Size – smaller, cheaper, and more efficient than second generation computers 

(they were called minicomputers). 

 Speed – improvement of speed and reliability (in comparison with the second 

generation computers).  

 Input / output devices – magnetic tape, keyboard, monitor, printer, etc.  

 Examples – IBM 360, IBM 370, PDP-11, UNIVAC 1108, etc. 

Fourth Generation of Computers 

The main characteristics of fourth generation of computers (1970s-present) 

Main electronic component – very large-scale integration (VLSI) and 

microprocessor.  

 VLSI– thousands of transistors on a single microchip.  

 Memory – semiconductor memory (such as RAM, ROM, etc.) 

o RAM (random-access memory) – a type of data storage (memory 

element) used in computers that temporary stores of programs and data 

(volatile: its contents are lost when the computer is turned off). 

o ROM (read-only memory) – a type of data storage used in computers 

that permanently stores data and programs (non-volatile: its contents are 

retained even when the computer is turned off). 

 Programming language – high level language (Python, C#, Java, JavaScript, 

Rust, Kotlin, etc.).  

o A mix of both third- and fourth-generation languages  

 Size – smaller, cheaper and more efficient than third generation computers.  

 Speed – improvement of speed, accuracy, and reliability (in comparison with 

the third generation computers). 

 Input / output devices – keyboard, pointing devices, optical scanning, monitor, 

printer, etc. 

 Network – a group of two or more computer systems linked together.  



 Examples – IBM PC, STAR 1000, APPLE II, Apple Macintosh, etc. 

Fifth Generation of Computers 

The main characteristics of fifth generation of computers (the present and 

the future)  

 Main electronic component: based on artificial intelligence, uses the Ultra 

Large - Scale Integration (ULSI) technology and parallel processing method.  

ULSI – millions of transistors on a single microchip  

Parallel processing method – use two or more microprocessors to run tasks 

simultaneously.  

 Language – understand natural language (human language).  

 Power – consume less power and generate less heat.  

 Speed – remarkable improvement of speed, accuracy and reliability (in 

comparison with the fourth generation computers).  

 Size – portable and small in size, and have a huge storage capacity.  

 Input / output device – keyboard, monitor, mouse, trackpad (or touchpad), 

touchscreen, pen, speech input (recognise voice / speech), light scanner, printer, 

etc. 

 Example – desktops, laptops, tablets, smartphones, etc. 

 

 

 

 

 

 

 

 

 



4. Difference between volatile memory and non volatile 

memories? 

Volatile Memory 

 

S.No 

 

Key 
 

Volatile Memory 
Non - Volatile 

Memory 

1. Data 

Retention 

Data is present till power 

supply is present 

Data remains even 

after power supply is 

not present 

2. Persistence Volatile memory data is not 

permanent. 

Non volatile memory 

data is permanent 

3. Speed Volatile memory is faster than 

non – volatile memory 

Non- volatile memory 

access is slower 

4. Example RAM is an example of 

Volatile Memory 

ROM is an example of 

Non- Volatile Memory 

5. Data 

Transfer 

Data Transfer is easy in 

Volatile Memory 

Data Transfer is 

difficult in Non-

Volatile Memory 

6. CPU Access CPU can access data stored 

on Volatile memory 

Data to be copied from 

Non – Volatile 

memory to Volatile 

memory so that CPU 

can access its data 

7. Storage Volatile memory less storage 

capacity 

Non-Volatile memory 

like HDD has very 

high storage capacity 

8. Impact Volatile memory such as 

RAM is high impact on 

system’s performance 

Non-Volatile memory 

has no impact on 

system’s performance 

9. Cost Volatile memory is costly per 

unit size 

Non-volatile memory 

is cheap per unit size 

 

 

 

 



5. Distinguish among system software application software and 

open source software on the basis of their features? 

System Software 

System software is meant to manage 

the system resources. It serves as the 

platform to run application software. 

System software is developed in a 

low-level language (assembly 

language for example) 

System software automatically starts 

running once the system is turned on 

and stops when the system is shut 

down 

A system cannot even start without 

system software 

System software is endowed with a 

general purpose. 

A typical example for a system 

software is Windows Operating 

System 

Application Software 

Application software helps perform 

a specified set of functions for which 

they have been designed. 

Application software is developed in 

a high – level language such as Java, 

C++, net and VB. 

Application software runs as and 

when the user requests it. 

 

Application software is user specific 

and it is not needed to run the 

system on the whole. 

Application software carries a 

specific purpose 

Some characteristic examples for 

application software is MS Office. 

Photoshop and CorelDraw 

The term open source refers to software whose source code — the medium in 

which programmers create and modify software — is freely available on the 

Internet; by contrast, the source code for proprietary commercial software is 

usually a closely guarded secret. 

The most well-known example of open source software is the Linux operating 

system, but there are open source software products available for every 

conceivable purpose. 

Open source software is distributed under a variety of licensing terms, but 

almost all have two things in common: the software can be used without paying 



a license fee, and anyone can modify the software to add capabilities not 

envisaged by its originators. 

A standard is a technology specification whose details are made widely 

available, allowing many companies to create products that will work 

interchangeably and be compatible with each other. Any modern technology 

product relies on thousands of standards in its design — even the gasoline you 

put in your car is blended to meet several highly-detailed specifications that the 

car’s designers rely on. 

For a standard to be considered an open standard, the specification and rights 

to implement it must be freely available to anyone without signing non-

disclosure agreements or paying royalties. The best example of open standards 

at work is the Internet — virtually all of the technology specifications it 

depends on are open, as is the process for defining new ones. 

An Application Programming Interface (API) is a feature of a software 

application that allows other software to inter-operate with it, automatically 

invoking its functionality and exchanging data with it. The definition of an API 

is a form of technology standard. The term open API doesn’t yet have a 

universally accepted definition, but it’s generally expected to be ―open‖ in the 

same manner as an open standard. 

The common theme of ―openness‖ in the above definitions is the ability of 

diverse parties to create technology that interoperates. When evaluating your 

organization’s current and anticipated software needs, consider a solution’s 

capability to interoperate as an important criterion. To extend the value of your 

technology investment, select a software solution that is based on open 

standards and APIs that facilitate interoperability and has the capability for 

direct integration between various vendors’ products. 

 



6. a) Create a file in MS -word to insert a paragraph about yourself and 

save  

it with file name “Yourself” Describe all steps involved in it. 

My name is R. BALVARNA, from Naduvakurichi. I have completed my 

Bachelors degree in Commerce from TDMNS College, T. Kallikulam, 

Tirunelveli District. 

6) b. Write steps regarding followings. 

i) To change the font style 

ii) To change the font size 

iii) To change the font colour 

iv) To highlight ( in yellow) in the that reads “Need to get IMS’s address”  

 

“R. BALVARNA’ 

D/o.N.Ranganathan, 

14/50, East Naduvakurichi, 

Kommadikottai (Via), 

Thoothukudi - Dist 

7. Create a file in MS word for the following document and save it 

with the file name “ms_word” Describe all the steps involved in it. 

MS Word 

 MS Word is a widely used commercial word processor developed by Microsoft  

MS Word is application software, which is capable of  

 Creating 

 Editing 

 Saving and 

 Printing any type of document 



8. Create a file in MS -word for the following document and save 

it with file name “equations”. Describe all steps involved in it. 

Equations 

X2 + Y5  = 30 

Z3 + Q4 = 50 

A2 + B8= X2 + Y8 

9. Create a file in MS-word that convert existing highlight text to table as 

shown below and save it as file name ‘text_to_table’. Describe all steps 

involved in it. 

Select the text you want to convert. 

Select the Insert tab. 

Click on Table command. A dialog box appears. 

Click on Convert Text to Table, a new dialog box appears 

Here set number of columns. 

Click on Ok Finally Selected text convert in a table 

Select the text you want to convert. Select the text you want to convert. 

Select the Insert tab. Select the Insert tab. 

Click on Table command. A dialog 

box appears. 

Click on Table command. A dialog 

box appears. 

 

 

 

 

 

 

 

 

 

 



10. Create a fill in Ms Word to insert a table in the document. Describe all  

      steps involved in it. 

1. Place your insertion point in the document where you want the table to appear. 

2. Select the insert tab. 

3. Click the table command 

4. Hover your mouse over the diagram squares to select the number of columns 

and rows in the table  

5. Click your mouse and the table appears in the document. 

6. You can now place the insertion point anywhere in the table to add text. 

 

 

 

 

 

 

 

11. Create a following worksheet in MS-excel and save it with name 

‘book1’. 

 



 

12. Calculate the following things of a range (C2:c11) of date in  

theworksheet create in question no 10. 

 the sum of the marks using Auto Sum in a range of cells (C2:C11) 

 average of the marks in a range of cells (C2:C11) 

 highest marks in a range of cells (C2:C11) 

 minimum marks in a range of cells (C2:C11) 



 

 

 

 

  

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

13. a) Describe various steps involved in the following 

To modify column width of a worksheet 

1. Select the column or columns that you want to change. 

2. On the Home tab, in the Cells group, click Format. 

3. Under Cell Size, click Column Width. 

4. In the Column width box, type the value that you want. 

5. Click Ok 

To modify the row height of a worksheet 

1. Select the row or rows that you want to change. 

2. On the Home tab, in the Cells group, click Format. 

3. Under Cell Size, click Row Height. 

4. In the Row height box, type the value that you want, and then click OK 

 



To delete rows and columns of a worksheet 

1. Select the cells, rows, or columns that you want to delete.  

2. Right-click, and then select the appropriate delete option, for example, Delete 

Cells & Shift Up, Delete Cells & Shift Left, Delete Rows, or Delete Columns. 

13.b) Describe following terms in the worksheet 

 Absolute reference and relative reference in formula 

Excel uses two types of cell references to create formulas.  Each has its own 

purpose.  Read on to determine which type of cell reference to use for your 

formula.  

Relative Cell References 

This is the most widely used type of cell reference in formulas.  Relative cell 

references are basic cell references that adjust and change when copied or when 

using AutoFill. 

Example: 

=SUM(B5:B8), as shown below, changes to =SUM(C5:C8) when copied across 

to the next cell. 

 

 



Absolute Cell References 

Situations arise in which the cell reference must remain the same when copied 

or when using AutoFill.  Dollar signs are used to hold a column and/or row 

reference constant. 

Example: 

In the example below, when calculating commissions for sales staff, you would 

not want cell B10 to change when copying the formula down.  You want both 

the column and the row to remain the same to refer to that exact cell.  By using 

$B$10 in the formula, neither changes when copied. 

 

 

A more complicated example: 

Let's pretend that you need to calculate the prices of items in stock with two 

different price discounts. Take a look at the worksheet below. 

 

 

 

 

 

 



Examine the formula in cell E4. By making the first cell reference $C4, you 

keep the column from changing when copied across, but allow the row to 

change when copying down to accommodate the prices of the different items 

going down. By making the last cell reference A$12, you keep the row number 

from changing when copied down, but allow the column to change and reflect 

discount B when copied across. Confused? Check out the graphics below and 

the cell results. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

Now, you might be thinking, why not just use 10% and 15% in the actual 

formulas? Wouldn't that be easier? Yes, if you are sure the discount percentages 

will never change - which is highly unlikely. It's more likely that eventually 

those percentages will need to be adjusted. By referencing the cells containing 

10% and 15% and not the actual numbers, when the percentage changes all you 



need to do is change the percentage one time in cell A12 and/or B12 instead of 

rebuilding all of your formulas. Excel would automatically update the discount 

prices to reflect your discount percentage change. 

 

Cell address 

A cell reference, or cell address, is an alphanumeric value used to identify 

a specific cell in a spreadsheet. Each cell address contains ‘one or more letters’ 

followed by a number. The letter or letters identify the column and the number 

represents the row. 

 

 

14. a) What tools are available to customize our Power Point Presentation? 

Microsoft has upped the PowerPoint customization within Office. Now you can 

choose themes, theme variants, foreground patterns and color and different fill 

effects to an previously unknown extent. 

Here's how to pretty up your next presentation. 

1. Choose a theme from PowerPoint’s preloaded themes, found under the 

Design tab. 

2. Pick a variant if you like, such as a different color, under the Design tab and 

next to the available themes. This will use the same layout as the theme you 

chose with a different color scheme. 

3. Customize your slides by choosing whether you’d like a solid, gradient, 

picture, texture or pattern fill, or whether you want to hide background graphics 

altogether. Click FormatBackground in the Design tab next to Variants, which 

will open a sidebar. Choose customized options such as fill, color, brightness 



and transparency. You can even insert your own picture as a background to your 

slide by selecting Picture Or Texture Fill then clicking Insert Picture From File 

or Online. Choose the picture you want to use, and click Open. 

4. Get even more creative within fills by choosing color, transparency and 

different patterns such as polka dots, diagonal patterns and diamonds. 

14. b) Write the steps for the following action for creation of Power Point   

       Presentation 

1. Open a Blank presentation 

2.Save the presentation as Lab1.pptx   

3.Add a Title to the first slide: the name of your college  

4.Type your first name and last name in the Subtitle section  

5.Add a New Slide which has a Title and Content 

 

 

 

 

 

 

 



 

15.Write steps for creation of a set of PowerPoint slides that demonstrates your  

skill to use the tools of PowerPoint. It should include the following things 

       a). Title slide &bullet list  

b). Inserting Excel Sheet 

c). Clip art and Text  

  d). Slide show effects 

a). Title slide &bullet list 

 Insert New Slide 

 Select layout and then select title slide 

 Enter text in the Title slide 

 Next insert Title and Content slide 

 Enter the Topic heading in Title text box 

 And then type the content in Bullets numbering text box. 

 If you want to change bullet type select bullets and numbering option and 

then change the bullet models. 

b). Inserting Excel Sheet 

 Next Insert another slide for Title and Content 

 Select Excel and insert data 

c). Clip art and Text 

 Insert new slide and then select title and content layout 

 Select Insert clipart command and then select clipart. 

d). Slide show effects 

 If you want apply any design in the selected slide, select design tab and 

then select any design to change the design of the selected slide. 

 If you want change any animation, select animation tab and then select 

any animation, click apply to the selected animation. 

 Finally to View to show the all slides. 

 

 

 



 

Part 2 

16. What is the different between machine language and High 

LevelLanguage? 

Machine language 

  It is also known as machine level language. 

 It can be understood easily by the machine.  

 It is considered as a machine-friendly language.  

 It is difficult to understand. 

 It is difficult to debug.  

 Its maintenance is also complex. 

 It is not portable. 

 It depends on the machine; hence it can't be run on different platforms. 

 It requires an assembler that would translate instructions. 

 It is not used widely in today's times. 

High – Level Language 

 It can be easily interpreted as well as compiled in comparison to low- 

level language.  

 It can be considered as a programmer-friendly language.  

 It is easy to understand.  

 It is easy to debug. 

 It is simple in terms of maintenance.  

 It requires a compiler/interpreter to be translated into machine code.  

 It can be run on different platforms. 

 It can be ported from one location to another.  



 It is less memory efficient, i.e it consumes more memory in comparison  

to low-level languages.  

 Examples of high level languages include C, C++, Java, Python.  

 It is used widely in today's times. 

We will now understand the differences between High-Level and Low-

Level programming languages − 

High-Level Language Machine language 

It can be considered as a programmer-

friendly language. 

It is considered as a machine-

friendly language. 

It requires a compiler/interpreter to be 

translated into machine code. 

It requires an assembler that would 

translate instructions. 

It can be ported from one location to 

another. 

It is not portable. 

It is easy to understand. It is difficult to understand. 

It is easy to debug. It is difficult to debug. 

It is less memory efficient, i.e., it 

consumes more memory in 

comparison to low-level languages. 

It consumes less memory. 

 

17. Discuss about different data types of C Programming language? 

Data Types in C 

 Data types specify how we enter data into our programs and what type of 

data we enter. C language has some predefined set of data types to handle 



various kinds of data that we can use in our program. These datatypes have 

different storage capacities. 

C language supports 2 different type of data types: 

1. Primary data types 

 These are fundamental data types in C namely integer (i n t), floating 

point (f l o a t), character (c h a r) and void 

2. Derived data types 

 Derived data types are nothing but primary datatypes but a little twisted 

or grouped together like array, structure, union and pointers. These are 

discussed in details later. 

Data type determines the type of data a variable will hold. If a variable x is 

declared as in t. It means x can hold only integer values. Every variable which is 

used in the program declared as what data – type it is. 

Integer type 

 Integers are used to store whole numbers. 

Size and range of Integer type on 16 – bit machine: 

 Type     Size (bytes)   Range 

int or signed int     2  -32, 768 to 32767 

unsigned int      2  0 to 65535 

short int or signed short int   1  - 128 to 127 

unsigned short int     1  0 to 255 

long int or signed long int   4  -2, 147,483,648, to 2,147,483,647 

unsigned long int     4  0 to 4,294,967,295 

Floating point type 

Floating types are used to store real numbers. 

Size and range of Integer type on 16 – bit machine 

Type     Size (bytes)   Range 

Float      4  3.4E-38 to 3.4E+38 



double     8  1.7E-308 to 1.7E+308 

long double      10  3.4E-4932 to 1.1E+4932 

Character type 

Character types are used to store character value. 

Size and range of integer type on 16 – bit machine. 

Type     Size (bytes)   Range 

char or signed char    1   -128 to 127 

unsigned char    1   0 to 255 

Void type 

Void type means no value. This is usually used to specify the type of functions 

which returns nothing. We will get acquainted to this datatype as we start 

learning more advanced topics in C language, like functions, pointers etc. 

 

18. Find the output of the following expressions 

a) X = 20/5*2+30-5 

            X = 4*2+30-5 

   X = 8+30-5 

   X = 38 – 5 

   X = 33 

      b) Y =30 – (40/10 + 6) +10 

Y = 30 – (4+6)+10 

Y = 30 – (10)+ 10 

Y = 20 + 10 

Y = 30 

      c) Z=40*2/10-2+10 

Z = 80/10 – 2 + 10 

Z = 8 – 2 +10 



Z =  6 + 10 

Z = 16 

19.Describe the syntax of the following statement 

a) If – else statement b) for loop c) while loop d) do-while loop 

a) If – else statement 

Syntax of if else statement 

 If condition returns true then the statement inside the body of “if” are 

executed and the statements inside body of “else” are skipped. 

If condition returns false then the statement inside the body of “if” are skipped 

and the statement in “else” are executed. 

if(condition){   

//statements inside body of if 

}   

else{   

//statements inside body else   

}   

Flow diagram of the else statement 

 

 

 

 

 

 

 

 

 

 

 



 

Example of if else statement 

In this program user is asked to enter the age and based on the input, the 

if..else statement checks whether the entered age is greater than or equal to 

18. If this condition meet then display message “You are eligible for voting”, 

however if the condition doesn’t meet then display a different message “You 

are not eligible for voting”. 

#inclued <stdio.h> 

Int main() 

{ 

Int age; 

Printf (“Enter your age”); 

Scanf(“%d”, & age); 

If (age>=18) 

{ 

 /*This statement will only execute if the  

  * above condition (age>=18) returns true 

 /* 

 Printf (“You are eligible for voting”); 

} 

else 

{ 

 /*This statement will only execute if the  



  *condition specified in the “if” returns false. 

 /* 

Printf (“You are eligible for voting”); 

} 

Return 0; 

} 

Output: 

Enter your age ; 14 

You are not eligible for voting 

b) For loop 

for Loop 

The syntax of the for loop is: 

for (initializationStatement;testExpression; updateStatement) 

{ 

// statements inside the body of loop 

} 

How for loop works? 

 The initialization statement is executed only once.  

 Then, the test expression is evaluated. If the test expression is evaluated to 

false, the for loop is terminated.  

 However, if the test expression is evaluated to true, statements inside the body 

of the for loop are executed, and the update expression is updated.  

Again the test expression is evaluated. 



This process goes on until the test expression is false. When the test expression 

is false, the loop terminates. 

To learn more about test expression (when the test expression is evaluated to 

true and false),  check out relational and logical operators. 

for loop Flowchart 

 

 

 

 

 

 

 

 

 

Working of for loop 

Example 1: for loop 

// Print numbers from 1 to 10                                                                                                                                 

 #include <stdio.h> 

int main() { 

   int i; 

for (i = 1; i< 11; ++i) 

{ 

printf("%d ", i); 

} 

return 0; 



} 

Output 

1 2 3 4 5 6 7 8 9 10 

1. i is initialized to 1. 

2. The test expression i< 11 is evaluated. Since 1 less than 11 is true, the body 

of for loop is executed. This will print the 1 (value of i) on the screen. 

3. The update statement ++i is executed. Now, the value of i will be 2. Again, 

the test expression is evaluated to true, and the body of for loop is executed. 

This will print 2 (value of i) on the screen. 

4. Again, the update statement ++i is executed and the test expression i< 11 is 

evaluated. This  process goes on until i becomes 11. 

5. When i becomes 11, i< 11 will be false, and the for loop terminates. 

c) While loop 

while loop 

The syntax of thewhileloop is: 

while (testExpression) { 

// the body of the loop 

} 

How while loop works? 

Thewhileloop evaluates thetestExpressioninside the parentheses (). 

IftestExpressionis true, statements inside the body of while loop are executed. Then, 

testExpressionis evaluated again. 

The process goes on untiltestExpressionis evaluated to false. 

IftestExpressionis false, the loop terminates (ends). 

To learn more about test expressions (whentestExpressionis evaluated to true and 

false), check out relational and logical operators. 



 

 

 

Flowchart of while loop 

 

 

 

 

 

 

 

 

Example 1: while loop 

// Print numbers from 1 to 5 

# include <stdio.h> 

int main () { 

int  i = 1; 

    while (i< = 5 ) { 

printf (“%d\n”, i ) ; 

        ++i ; 

} 

Return 0; 

} 

Output 



1 

2 

3 

4 

5 

Here, we have initialized i to 1.  

1. Wheni = 1, the test expressioni<= 5 is true. Hence, the body of the while loop is 

executed. This prints 1 on the screen and the value of i is increased to 2. 

2. Now, i = 2, the test expressioni<= 5 is again true. The body of the while loop is 

executed again. This prints 2 on the screen and the value of i is increased to 3. 

3. This process goes on until i becomes 6. Then, the test expressioni<= 5 will be 

false and the loop terminates. 

d) Do – while loop 

The do..while loop is similar to the while loop with one important difference. 

The body ofdo...while loop is executed at least once. Only then, the test 

expression is evaluated. 

The syntax of the do...while loop is: 

do { 

// the body of the loop 

} 

while (testExpression); 

How do...while loop works? 

 The body of do...while loop is executed once. Only then, the testExpression is 

evaluated. 

 If testExpression is true, the body of the loop is executed again and 

testExpressionis evaluated once more. 

 This process goes on until testExpression becomes false. 



 If testExpression is false, the loop ends. 

 

 

Flowchart of do while loop 

 

Example 2: do...while loop 

// program to add numbers until the user enters zero 

# include <stdio.h> 

Int main () { 

Double number, sum = 0; 

// the body of the loop is executed at least once  

Do { 

Printf (“Enter a numbers: “); 

Scanf (“%1f”, & number); 

Sum += number; 

} 

While (number ! = 0.0); 



Printf (“dum = %.21f”, sum); 

Return 0; 

 

Output 

Enter a number: 1.5 

Enter a number: 2.4 

Enter a number: -3.4 

Enter a number: 4.2 

Enter a number: 0 

Sum = 4.70 

Here, we have used a do...while loop to prompt the user to enter a number. The 

loop works as long as the input number is not 0. 

The do...while loop executes at least once i.e. the first iteration runs without 

checking the condition. The condition is checked only after the first iteration 

has been executed. 

do { 

printf(“Enter a number : “); 

scanf (%if “, & number); 

  sum + = number; 

} 

while (number ! = 0.0 );  

So, if the first input is a non-zero number, that number is added to the sum 

variable and the loop continues to the next iteration. This process is repeated 

until the user enters 0. 

But if the first input is 0, there will be no second iteration of the loop and sum 

becomes 0.0. 

Outside the loop, we print the value of sum. 



20. Find the output of the following program segments 

a) b) c) 

#include <stdio.h> 

  int main() 

{ 

Int i; 

For (i=1; i<2; i++) 

{ 

Printf(“ IMS Ghaziabad\n”); 

} 

} 

#include <stdio.h> 

  int main() 

{ 

Int I = 1; 

while (i<2) 

{ 

Printf(“ IMS 
Ghaziabad\n”); 

i = i + 1; 

} 

} 

#include <stdio.h> 

Void main () 

{ 

int a = 10, b = 100; 

if ( a>b) 

printf(“Largest number is %d\n”,a); 

else 

printf(“Largest number is %d\n”,b); 

} 

Result Result Result 

IMS Ghaziabad IMS Ghaziabad 

IMS Ghaziabad 

main.c: In function ‘main’: main.c:6:8: 
warning: missing 
terminating"character printf("Largest 
number is %d\n”, a); 

                      ^ 

main.c:6:8: error: missing terminating 
" character 

printf("Largest number is %d\n”,  

a);  

^~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ 
main.c:7:1: error: expected  

expression before ‘else’                      
else 

^~~~                                                       
main.c:8:8: warning:  missing 
terminating " character 



printf("Largest number is %d\n”,        
b);  

                        ^ 

main.c:8:8: error: missing               
terminating " character 

printf("Largest number is %d\n”,         
b); 
^~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ 
main.c:9:1: error: expected     
declaration or statement at end          
of input 

} 

^ 

 

 

 

 

 

 

 

 

 


